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File menu commands

The File menu offers the following commands:

Save Saves an opened document using the same file name.
Exit Exits Chores & Rewards.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Setup menu commands

The Setup menu offers the following commands:

Kids... Goes to Kids Setup.
Chores... Goes to Chores Setup.
Penalties... Goes to Penalties Setup.
Rewards... Goes to Rewards Setup.
Prizes... Goes to Prizes Setup.



Activities menu commands

The Activities menu offers the following commands:

Choose a Kid Starts the Kid Selection dialog.
Check-Off 
Chores

Goes to the Chores Checklist view.

Charge 
Penalties

Goes to Charge Penalties view.

Give Rewards  Goes to the Give Rewards view.
Select Prizes Starts the Select Prizes dialog.
Do Banking Starts the Do Banking dialog.
Run Payday Runs Payday process on the currently selected Kid.



Print menu commands

The Print menu offers the following commands:

Print Prints the active view.
Print Preview Print preview of the active view.
Print Setup Setup and select printer.



Save command (File menu)

Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Chores & Rewards displays the Save As dialog box so
you can name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts
Keys: CTRL+S



Exit command (File menu)

Use this command to end your Chores & Rewards session.    You can also use the Close 
command on the application Control menu.    Chores & Rewards prompts you to save 
documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Chores & Rewards, such as File Open.    A check mark appears 
next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Chores & Rewards,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Invoke the Setup Kids function to add, change and delete Kids.

Invoke the Setup Chores function to add, change and delete Chores and their 
associated Kid assignments and schedules..

Invoke the Setup Penalties function to add, change and delete Penalties and their 
associated eligible Kid assignments.

Invoke the Setup Rewards function to add, change and delete Rewards and their 
associated eligible Kid assignments.

Invoke the Setup Prizes function to add, change and delete Prizes and their 
associated eligible Kid assignments..

Invoke the Select Kid function to change Kid selection.

Invoke the Check-off Chores function to list the Chore assignments and schedules 
for the currently selected Kid.

Invoke the Charge Penalties function to list the applicable Penalties assigned to the
currently selected Kid.

Invoke the Give Rewards function to list the eligible Rewards assigned to the 
currently selected Kid..

Invoke the Select Prizes function to buy Prizes from the list assigned to the 
currently selected Kid..

Run Payday to reconcile completed Chore, Reward and Penalty lists and compute 
compensation for the currently selected Kid..



Invoke the Check Balances function to do inquiries, deposits and withdrawals into 
the bank account for the currently selected Kid.

Invoke the Print function for    the active view.

Invoke the Help table of contents..



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Chores & Rewards window.    To display or 
hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this document 
window.



1, 2, ... command (Window menu)

Chores & Rewards displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.  
Choose a document from this list to make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Chores & Rewards and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Chores & Rewards.

SHIFT+F1



Title Bar

Chores & Rewards - CHORE1.CHR

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Chores & Rewards window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Chores & Rewards 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Chores & Rewards 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4

ALT+F4



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    



Introduction
Do your kids do chores? Do they get allowance for their chores? Do your kids occasionally 
leave messes?...fail to mind you?...fight with their siblings? Do they get punished for this? Do
your kids do good deeds too? Do they get rewarded for these?

How do you reconcile allowance for chores, rewards for good deeds and punishment for 
misbehavior to determine the appropriate compensation? 

Chores & Rewards provides a system for defining, tracking and reconciling chores, good 
deeds and misconduct while teaching your children responsibility and accountability.

With Chores & Rewards you can...

Setup Chore schedules, Reward checklists, and Penalty checklists for each child
Use cash, points, or your own formula as compensation and incentives
Setup Savings Plans for each child as a percentage or exact amount of compensation
Setup special Prizes to be awarded when certain point levels are reached
Printout Chore schedules, Reward checklists, and Penalty checklists for each child
Reconcile Chores, Rewards and Penalties to determine net compensation on Payday
Make automatic deposits of Payday compensation into a Bank Account for each child
Make deposits and withdrawals into the Bank Account to maintain accurate balances



Benefits
Both parents and children will benefit from using Chores & Rewards. 

Children become more responsible and accountable by...
Participating in establishing Rewards and Penalties for good deeds and misbehavior
Having Chores and good deeds reinforced with predetermined compensation
Having clearly stated (and mutually agreed upon) Penalties for misbehavior
Having a clearly defined schedule of chores
Maintaining their own Bank Account of their compensation from their Chores and 

Rewards
Becoming more computer-literate operating a typical full-feature Windows computer 

application

Parents will enjoy the benefits of more responsible, accountable children... 
Chores are performed more regularly, reliably and with less reminding
Misbehavior is reduced by having mutually agreed upon and clearly defined 

punishment
Children do more good deeds because of the Reward incentives
Allowance is automatically determined by reconciling Chores, Rewards and Penalties
A Bank Account balance is automatically maintained for each child relieving the need 

to keep track of how much is owed each child



Incentives
Chores & Rewards provides three incentive methods that may be used separately or in 
combination to provide the necessary motivation for children to do Chores and Good Deeds 
while minimizing bad behavior. 

Cash A cash value is assigned to each Chore, Reward and Penalty.    The Payday 
process computes the cash due by adding the cash values of all completed Chores and 
Rewards, less any Penalties, and adjusts the Bank Account total cash and total savings with 
a Payday deposit..

Points A point value is assigned to each Chore, Reward and Penalty.    The Payday 
process computes the total points due by adding the point values of all completed Chores 
and Rewards, less any Penalties, and adjusts the Bank Account total points with a Payday 
deposit.
The accumulated points may be used to buy predefined Prizes with the Select Prize function.

User-defined You may wish to define your own incentives as Rewards and Penalties.   
These may be defined when a Reward or Penalty s setup.    A good example of a user-defined
incentive is a privilege, such watching TV, staying up late, etc.,...

The right formula of incentives is vital to successful motivation.    Therefore it is 
recommended that a good deal of thought be given to selecting your incentives.    It is also 
vital that both parents and kids agree to these incentives (you might even consider having 
everyone sign the Chore, Reward and Penalty checklists as a testament of their acceptance).
The rewards and penalties must be considered fair to all involved to promote the 
cooperative spirit that is essential to its success. 



Setup Procedures
Chores & Rewards operates on a single setup of Kids, Chores, Penalties, Rewards and Prizes. 
When you startup Chores & Rewards for the first time, you are prompted too defined a setup
for each of these categories.    You may change your setup at any time after this initial setup.

The setup steps are as follows...

1.    Setup Kids
2.    Setup Chores
3.    Setup Penalties
4.    Setup Rewards
5.    Setup Prizes



Welcome to Chores & Rewards
This window is displayed the first time you start Chores & Rewards in order to prompt the 
initial setup procedure.    You should perform each setup step in the order listed.    This initial 
setup may be changed later, so you dont need to worry about defining everything right the 
first time.

Help on each setup step may be accessed by clicking the help topics below.    For more 
general information about Chores & Rewards, see the Help Contents.

The setup steps are as follows...

1.    Setup Kids
2.    Setup Chores
3.    Setup Penalties
4.    Setup Rewards
5.    Setup Prizes



Using Checklists
Once setup is completely defined, checklists of Chores, Penalties and Rewards may be 
printed for each Kid.    The checklists will be used during the week to keep track of 
completed chores, good deeds and misbehavior.    At the end of the week, the checklists are 
transferred to the Chores & Rewards system for Payday processing.

Heres a few hints for using the checklists...

Keep checklists in a convenient location to both parents and kids so that no one 
forgets to check something off.

Parents can mark undone chores with an X to indicate it was not done, or not done on
schedule.

Parents can write in new Chores, Rewards and Penalties on the appropriate checklist 
for each child so that they can be added to the setup at the next Payday.

Once your setup stabilizes, make several copies of each checklist so that they dont 
have to be reprinted each week.

After they have learned the procedure, let the kids enter their checklists on Chores & 
Rewards and run their own Payday.    This will save time for the parents and the kids will 
enjoy seeing how their hard work pays off.    They can then print out the Payday report for 
parents review.

See Print Checklists for How-To print off checklists of Chores, Rewards and Penalties for each 
Kid.



Running Payday
At the end of each week you will transfer your checklists of Chores, Rewards and Penalties 
for each Kid using the corresponding Check-Off Chores, Give Rewards and Charge Penalties 
activities.    After this is complete, you are ready to run Payday.    A Payday is processed for 
each Kid and performs the following tasks...

Computes total Cash and Points for completed Chores.
Computes total Cash and Points for Rewards.
Computes total Cash and Points for Penalties.
Computes the Payday total for Cash and Points by adding Chores and Rewards and 

subtracting Penalties.
Deducts the Savings Deduction (percent or amount) if specified.
Computes total due Cash and Points.
Deposits total due Cash, Points and Savings Deduction into the Bank Account.
Writes a congratulation message if the total accumulated points reaches a level that 

is eligible to purchase a Prize.

See Run Payday for How-To start the Payday process.



Using the Bank Account
The Bank Account is a feature of Chores & Rewards that allows each child to maintain a bank
account of Cash, Points and Savings.    The Payday process does an automatic deposit of 
Cash, Points and Savings into the Bank Account for each Kid.    Kids can use their Bank 
Account to keep track of their available funds and make withdrawals and deposits.    This 
provides a convenient alternative to weekly cash payments for parents.    Whenever a child 
wants cash from their Bank Account they make a withdrawal and get then cash from their 
parents.    This is a lot easier than messing with cash each week or trying to remember how 
much money each kid has available to spend.

See Do Banking for How-To access Bank Account information and perform deposits and 
withdrawals.



Setup and Change Kids
The first step of the setup procedure is to define a Kid record for each participant.    This 
simply involves entering the first name and an optional savings deduction for each child.    
Later, Chores, Rewards, Penalties and Prizes will be assigned separately to each Kid.    The 
change function allows Kids to swap assignments with each other, which can be useful if 
someone is not available for a period.

There are two ways to start the Setup Kids dialog...

1.    Click on the Setup command on the menu and then click on Kids...
2.    Click on the  toolbar icon.



Setup and Change Chores
This setup step defines all repetitive Chores and their Kid assignments and schedules.    This 
involves describing each Chore, defining its compensation, assigning it to the Kid(s) that will 
perform them, and setting up a schedule for when they should be done (for example: 
Monday, Wednesday, and Friday afternoons).    Chores and their Kid assignments and 
schedules may be changed at any time after they are originally defined.

There are two ways to start the Setup Chores dialog...

1.    Click on the Setup command on the menu and then click on Chores...
2.    Click on the  toolbar icon.



Setup and Change Rewards
This setup step defines all Good Deeds or other activities that should be rewarded and 
assigns them to the eligible Kids.    This involves describing each Good Deed and its 
associated Reward, and assigning it to each eligible Kid.    Good Deeds, Rewards and their 
Kid assignments may be changed at any time after they are originally defined.

There are two ways to start the Setup Rewards dialog...

1.    Click on the Setup command on the menu and then click on Rewards...
2.    Click on the  toolbar icon.



Setup and Change Penalties
This setup step defines all Offenses or other misbehavior that should be penalized and 
assigns them to the eligible Kids.    This involves describing each Offense and associated 
Penalty, and assigning it to each eligible Kid.    Offenses, Penalties and their Kid assignments 
may be changed at any time after they are originally defined.

There are two ways to start the Setup Penalties dialog...

1.    Click on the Setup command on the menu and then click on Penalties...
2.    Click on the  toolbar icon.



Setup and Change Prizes
This setup step may be used to define all Prizes that may be bought with    Chore and Reward
points.    The idea here is to provide additional incentives for Kids to continue with their 
Chores and Good Deeds by accumulating points that they can use to buy Prizes.    This 
involves describing each Prize and its point cost, and assigning it to each eligible Kid.    Prizes
and their Kid assignments may be changed at any time after they are originally defined.

There are two ways to start the Setup Prizes dialog...

1.    Click on the Setup command on the menu and then click on Prizes...
2.    Click on the  toolbar icon.



Setup Kids Dialog
This dialog window lists all currently defined Kids and allows you to...

Add new Kids
Change a Kids name or savings deduction
Delete a Kid

The Add, Change and Delete buttons are used in conjunction with a selection from the list 
box.    The Cancel button may be used to abandon any changes that you have made since 
entering the dialog window.    The OK button may be used to accept your changes.



Add Kid
This dialog window allows you to add a new Kid to your setup.    Just enter the childs first 
name and an optional Savings Deduction.



Savings Deduction

The Savings Deduction is automatically deducted from each Payday total and deposited into 
the Savings account.    Savings Deductions may be defined as dollar amounts or percentage. 
The dollar amount must be specified in dollars and cents (ex. 1.25). The percentage must be
specified in whole numbers (ex. 10).    Note: if a dollar amount is used and a Payday total is 
less than the dollar amount, the entire Payday total will be deducted.



Change Kid
This dialog window allows you to change a previously defined Kid in your setup.    Just 
overtype the childs first name and optional Savings Deduction.



Delete Kid
This dialog window allows you to delete a previously defined Kid from your setup.    Just click 
on the Delete button to delete the Kid or click on Cancel to abandon quit without deleting..



Setup Chores Dialog
This dialog window lists all currently defined Chores and allows you to...

Add new Chores
Change a Chores description or incentives
Delete a Chore
Modify a Chore Assignment

The Add, Change, Delete and Assignment buttons are used in conjunction with a 
selection from the list box.    The Cancel button may be used to abandon any changes that 
you have made since entering the dialog window.    The OK button may be used to accept 
your changes.



Add Chore
This dialog window allows you to add a new Chore to your setup.    Just enter a short 
description (24 characters max.) of the Chore and the Cash and/or Point incentive.    The 
Cash Value should be specified in dollars and cents (i.e. 1.25).    The Point Value should be 
specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Change Chore
This dialog window allows you to change a previously defined Chore in your setup.    Just 
overtype the short description (24 characters max.) and the Cash and/or Point Value. The 
Cash Value should be specified in dollars and cents (i.e. 1.25).    The Point Value should be 
specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Delete Chore
This dialog window allows you to delete a previously defined Chore from your setup.    Just 
click on the Delete button to delete the Chore or click on Cancel to abandon quit without 
deleting..



Kid Assignment
This dialog window lists all current Kid assignments for a Chore and allows you to...

Add new Kid assignments
Change a Kid assignment
Delete a Kid assignment
Modify a Chore Assignment Schedule

The Add, Change, Delete and Schedule buttons are used in conjunction with a selection 
from the list box.    The Cancel button may be used to abandon any changes that you have 
made since entering the dialog window.    The OK button may be used to accept your 
changes.



Add Assignment
This dialog window allows you to add a new Kid Assignment for a Chore, Reward, Penalty or 
Prize to your setup.    Just select a    Kid from the list and click the OK button. 



Change Assignment
This dialog window allows you to change a previously defined Kid Assignment for a Chore, 
Reward, Penalty or Prize in your setup.    Just select the new Kid for the assignment and click 
the OK button.    Note: the Change Assignment function is useful because it transfers the 
Chore Schedule from the old Kid assignment to the new Kid assignment.



Delete Assignment
This dialog window allows you to delete a previously defined Kid Assignment for a Chore, 
Reward, Penalty or Prize from your setup.    Just click on the Delete button to delete the Kid 
Assignment or click on Cancel to abandon quit without deleting..



Chore Assignment Schedule
This dialog window lists the current schedule for a Chore assignment and allows you to...

Add new Schedule time
Change a Schedule time
Delete a Schedule time

The Add, Change and Delete buttons are used in conjunction with a selection from the list 
box.    The Cancel button may be used to abandon any changes that you have made since 
entering the dialog window.    The OK button may be used to accept your changes.



Add Chore Assignment Schedule
This dialog window allows you to add a new Schedule time for a Chore assignment to your 
setup. Just select a Day and Time from each list and click the OK button. 



Change Chore Assignment Schedule
This dialog window allows you to change a previously defined Schedule time for a Chore 
assignment in your setup. Just select the new Day and Time from each list and click the OK 
button. 



Delete Chore Assignment Schedule
This dialog window allows you to delete a previously defined Schedule time for a Chore 
assignment in your setup. Just click on the Delete button to delete the Schedule time or 
click on Cancel to abandon quit without deleting.



Setup Penalties Dialog
This dialog window lists all currently defined Penalties and allows you to...

Add new Penalties
Change a Penalty description or punishment
Delete a Penalty
Modify a Penalty Assignment

The Add, Change, Delete and Assignment buttons are used in conjunction with a 
selection from the list box.    The Cancel button may be used to abandon any changes that 
you have made since entering the dialog window.    The OK button may be used to accept 
your changes.



Add Penalty
This dialog window allows you to add a new Penalty to your setup.    Just enter a short 
description (24 characters max.) of the Penalty Offense and the Cash, Point or user-defined 
punishment.    The Cash Value should be specified in dollars and cents (i.e. 1.25).    The Point 
Value should be specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Change Penalty
This dialog window allows you to change a previously defined Penalty in your setup.    Just 
overtype the Offense short description (24 characters max.) and the Cash, Point or user-
defined punishment.    The Cash Value should be specified in dollars and cents (i.e. 1.25).    
The Point Value should be specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Delete Penalty
This dialog window allows you to delete a previously defined Penalty from your setup.    Just 
click on the Delete button to delete the Penalty or click on Cancel to abandon quit without 
deleting..



Kid Assignment
This dialog window lists all current Kid assignments for a Penalty, Reward or Prize and allows 
you to...

Add new Kid assignments
Change a Kid assignment
Delete a Kid assignment

The Add, Change and Delete buttons are used in conjunction with a selection from the list 
box.    The Cancel button may be used to abandon any changes that you have made since 
entering the dialog window.    The OK button may be used to accept your changes.



Setup Rewards Dialog
This dialog window lists all currently defined Rewards and allows you to...

Add new Rewards
Change a Reward description or incentive
Delete a Reward
Modify a Reward eligibility Assignment

The Add, Change, Delete and Assignment buttons are used in conjunction with a 
selection from the list box.    The Cancel button may be used to abandon any changes that 
you have made since entering the dialog window.    The OK button may be used to accept 
your changes.



Add Reward
This dialog window allows you to add a new Reward to your setup.    Just enter a short 
description (24 characters max.) of the Reward Good Deed and the Cash, Point or user-
defined incentive.    The Cash Value should be specified in dollars and cents (i.e. 1.25).    The 
Point Value should be specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Change Reward
This dialog window allows you to change a previously defined Reward in your setup.    Just 
overtype the Good Deed short description (24 characters max.) and the Cash, Point or user-
defined incentive.    The Cash Value should be specified in dollars and cents (i.e. 1.25).    The 
Point Value should be specified as a whole number (i.e. 10).

See the Incentives section for hints on defining rewards and punishment.



Delete Reward
This dialog window allows you to delete a previously defined Reward from your setup.    Just 
click on the Delete button to delete the Reward or click on Cancel to abandon quit without 
deleting..



Setup Prizes Dialog
This dialog window lists all currently defined Prizes and allows you to...

Add new Prizes
Change a Prize description or points needed
Delete a Prize
Modify a Prize eligibility Assignment

The Add, Change, Delete and Assignment buttons are used in conjunction with a 
selection from the list box.    The Cancel button may be used to abandon any changes that 
you have made since entering the dialog window.    The OK button may be used to accept 
your changes.



Add Prize
This dialog window allows you to add a new Prize to your setup.    Just enter a short 
description (24 characters max.) of the Prize and the number of Points Needed.

See the Incentives section for hints on defining rewards and punishment.



Change Prize
This dialog window allows you to change a previously defined Prize in your setup.    Just 
overtype the short description (24 characters max.) and the Points Needed.

See the Incentives section for hints on defining rewards and punishment.



Delete Prize
This dialog window allows you to delete a previously defined Prize from your setup.    Just 
click on the Delete button to delete the Prize or click on Cancel to abandon quit without 
deleting..



Print Checklists
After all Chore schedules, Penalties and Rewards have been setup, checklists can be printed 
for each child.    The checklists provide a reminder of chore schedules, penalties and rewards 
as well as a means of tracking them.    Chore checklists are used during the week by each 
child to remind them of their schedule and mark off chores.    Penalty and Reward checklists 
are used by parents to track good and bad behavior and to institute new rules.

Checklists of Chores, Penalties and Rewards may be printed from the corresponding Check-
Off Chores, Charge Penalties and Give Rewards activities.

There are two ways to start Print processing...

1.    Click on the Print command on the menu.
2.    Click on the  toolbar icon.



Change Kid Selection
All Chores & Reward activities are associated with a specific Kid. The Choose a Kid activity 
can be used at any time to change Kid selection.    Note: be sure, especially when running 
Payday, that the correct child has been selected.

There are two ways to start the Choose a Kid dialog...

1.    Click on the Activities command on the menu and then click on Choose a Kid.
2.    Click on the  toolbar icon.



Kid Selection
The Kid Selection dialog is used to change to current Kid Selection.    The currently selected
Kid is shown in the a selection box within the list.    To change Kid selection, just click on the 
desired Kid name and then click the OK button.
 



Check-Off Chores
The Check-off Chores activity is used to transfer completed chores from the printed checklist
into the Chores & Reward system so that Payday can be processed.

There are two ways to start the Check-off Chores dialog...

1.    Click on the Activities command on the menu and then click on Check-off Chores.
2.    Click on the  toolbar icon.



Chores Checklist
The Chores Checklist shows the complete chore schedule for the selected Kid.    It lists the 
Day, Time and Description of each chore.    The Cash and Point potential (if all chores are 
completed) is shown at the bottom.    The Chores Checklist function can be used at the end 
of each week to transfer chore status from the printed checklist into the Chores & Rewards 
system so that Payday can be processed.    To mark a chore complete, you can either double-
click on the chore item, or select a chore item and click on the Check button.    A check mark
(/) will appear under the Check column to indicate the chore was completed.    To remove a 
check mark, just double-click again.



Charge Penalties
The Charge Penalties activity is used to transfer penalties from the printed checklist into the 
Chores & Reward system so that Payday can be processed.

There are two ways to start the Charge Penalty dialog...

1.    Click on the Activities command on the menu and then click on Charge Penalties.
2.    Click on the  toolbar icon.



Charge Penalties
The Charge Penalties function shows all the applicable Penalties assigned to the selected 
Kid.    It lists a description of the offense (Offense), the total number of times ever charged 
(Total Counts), and the number of times charged since the last Payday (New Counts).    The 
Charge Penalties function can be used at the end of each week to transfer Penalty checks 
from the printed checklist into the Chores & Rewards system so that Payday can be 
processed.    To charge Penalties, you can either double-click on the Offense, or select the 
Offense and click on the Add button.    Each charge increments the New Count number.    To 
subtract from the New Count on a particular Offense (i.e. because you over-charged), select 
the Offense and click on the Subtract button.
 



Give Rewards
The Give Rewards activity is used to transfer rewards from the printed checklist into the 
Chores & Reward system so that Payday can be processed.

There are two ways to start the Give Rewards dialog...

1.    Click on the Activities command on the menu and then click on Give Rewards.
2.    Click on the  toolbar icon.



Give Rewards
The Give Rewards function shows all the eligible Rewards assigned to the selected Kid.    It 
lists a description of the good deed (Good Deed), the total number of times ever received 
(Total Counts), and the number of times received since the last Payday (New Counts).    The 
Give Rewards function can be used at the end of each week to transfer Reward checks from 
the printed checklist into the Chores & Rewards system so that Payday can be processed.    
To give Rewards, you can either double-click on the Good Deed, or select the Good Deed and
click on the Add button.    Each charge increments the New Count number.    To subtract from
the New Count on a particular Good Deed, select the Good Deed and click on the Subtract 
button.



Run Payday
The Run Payday activity is used to process the Payday for the currently selected Kid.

There are two ways to start the Run Payday process...

1.    Click on the Activities command on the menu and then click on Run Payday.
2.    Click on the  toolbar icon.



Payday
The Payday function processes all Chores, Penalties and Rewards for the selected Kid and 
determines allowance due.    The Payday function is processed after completing the Chores 
Checklist, Charge Penalties and Give Rewards functions have been completed for the Payday
period.    A Payday report is produced that contains Chores Completed, Rewards Earned and 
Penalties Charged sections and a Totals section.

Chores Completed 

This section lists the schedule Day and Time, Chore description, Cash value and Point value 
of each Chore completed followed by a section Cash and Point total.

Rewards Earned

This section lists the Good Deed, Reward Description, Cash value and Point value of each 
Reward received followed by a section Cash and Point total.

Penalties Charged 

This section lists the Offense, Penalty description, Cash cost and Point cost of each Penalty 
charged followed by a section Cash and Point total. 

Totals

This last section lists the total allowance due (Total Due) as the difference between the 
Payday Total and the Savings Deduction.      

The Total Due amount and Payday Total points are automatically deposited into the Kids 
Bank Account.    If the Bank Account Total Points reaches a level that becomes eligible to 
receive Prizes, a congratulations message is written and the Select Prizes function may be 
used to chose a prize.
.



Select Prizes
The Select Prizes activity is used to select prizes when a accumulated point level is reached.

There are two ways to start the Select Prizes dialog...

1.    Click on the Activities command on the menu and then click on Select Prizes.
2.    Click on the  toolbar icon.



Select Prizes
The Select Prizes function shows prize eligibility for the selected Kid.    It shows the total 
points available for the selected Kid to buy prizes, the prizes that prizes that he/she is 
eligible to buy, and the prizes that have previously been awarded.    If no prizes are listed in 
the Eligible Prizes box, there are not enough points to buy a prize.    

To select a prize, just double-click on the desired prize in the Eligible Prizes box.    The 
selected prize will be added to the Awarded Prizes box and the point cost of the prize will be 
used to reduce the total points available to buy prizes.    The Eligible Prizes list will then be 
recreated considering the new total point value.



Do Banking
The Do Banking activity is used to access the Bank Account for the currently selected Kid to 
check balances or make deposits or withdrawals.

There are two ways to start the Do Banking dialog...

1.    Click on the Activities command on the menu and then click on Do Banking.
2.    Click on the  toolbar icon.



Do Banking
The Do Banking function shows all the current Bank Account register and balances for the 
selected Kid and allows bank deposits and withdrawals to be processed.    It shows the 
current Total Cash, Total Savings, and Total Point balances above the Register box.    The 
Register box lists all bank activity (deposits and withdrawals) by Date along with the 
transaction type (D for Deposit, W for withdrawal), transaction description, cash, savings and
point values.

New transactions may be added by clicking on the Add button.    Invalid transactions may be 
deleted by selected the transaction from the Register box and clicking on the Delete button.



Add Transaction
To add a new transaction to the Bank Account, click the transaction type button (Deposit or 
Withdrawal), enter the Date (if not current date), a transaction description, the Cash 
Amount, Savings Amount and Points. 

Note: The Cash and Savings Amounts should be specified in dollars and cents (i.e. 1.25).    
The Points should be specified as a whole number (i.e. 10).



Delete Transaction
To delete a transaction to the Bank Account, verify that the correct transaction has been 
selected, and click the Delete button.



Shareware Definition
Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy. And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it. 

DISCLAIMER - AGREEMENT

Users of Chores & Rewards must accept this disclaimer of warranty: "Chores & Rewards is 
supplied as is.    The author disclaims all warranties, expressed or implied, including, without 
limitation, the warranties of merchantability and of fitness for any purpose. The author 
assumes no liability for damages, direct or consequential, which may result from the use of 
Chores & Rewards."

Chores & Rewards is a "shareware program" and is provided at no charge to the user for 
evaluation.    Feel free to share it with your friends, but please do not give it away altered or 
as part of another system.    The essence of "user-supported" software is to provide personal 
computer users with quality software without high prices, and yet to provide incentive for 
programmers to continue to develop new products.    If you find this program useful and find 
that you are using Chores & Rewards and continue to use Chores & Rewards after a 
reasonable trial period, you must make a registration payment of $20.00 to K. Jeff Hayes.    
The $20.00 registration fee will license one copy for use on any one computer at any one 
time.    You must treat this software just like a book.    An example is that this software may 
be used by any number of people and may be freely moved from one computer location to 
another, so long as there is no possibility of it being used at one location while it's being 
used at another. Just as a book cannot be read by two different persons at the same time.

Commercial users of Chores & Rewards must register and pay for their copies of Chores & 
Rewards within 30 days of first use or their license is withdrawn.    Site-License arrangements
may be made by contacting K. Jeff Hayes.

Anyone distributing Chores & Rewards for any kind of remuneration must first contact K. Jeff 
Hayes at the address below for authorization. This authorization will be automatically 
granted to distributors recognized by the (ASP) as adhering to its guidelines for shareware 
distributors, and such distributors may begin offering Chores & Rewards immediately 
(However K. Jeff Hayes must still be advised so that the distributor can be kept up-to-date 
with the latest version of Chores & Rewards.).



You are encouraged to pass a copy of Chores & Rewards along to your friends for evaluation. 
Please encourage them to register their copy if they find that they can use it.    All registered 
users will receive a copy of the latest version of the Chores & Rewards system.

K. Jeff Hayes
P.O. Box 1459
1055 Business Highway 64 East
Wendell, NC 27591

(919) 365-6027
Compuserve Account: 71652,634



Registration Form
Please print this form (by clicking File and then Print Topic), fill in the information and mail it 
along with a check or money order for $20.00 (plus S&H). payable to K. Jeff Hayes at the 
address below:

K. Jeff Hayes
P.O. Box 1459
Wendell, NC 27591

Your return address: 

Name:          ___________________________________________________________________

Address:    ___________________________________________________________________

City:                  ______________________________ State ____    Zip _______________________

____$20.00 Registration Fee
_________    Shipping & Handling ($3.00 to US or Canada, $5.00 to other locals)
_________    Total 

Number of children in you family:    _____

If you have a helpful hint or motivational tip, please enter it below.    If your tip is accepted 
for publishing in the Chores & Rewards Forum, you will receive a $2.00 rebate on your 
registration fee. (Note: you may enter as many tips as you like on an additional sheet of 
paper.    If one or more of your tips is accepted, you will receive the $2.00 rebate).    

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you have a suggestion of a way to improve the Chores & Rewards system, please enter it 
below: 

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________



Support Policy
Technical support will be provided for 90 days after registration by phone or Compuserve 
mail.
Telephone support will be available between 9:00 AM and 5:00 PM EST, Monday through 
Friday except for holidays.    Compuserve mail will be responded to within 2 working days of 
the day that it is received. 

Any software problems reported during the 90 day period, which disables the use of any 
system function, will be corrected within 30 days and the customer will receive a new 
version of the software containing corrections to the problems.    If, within the 90 day period, 
the resolution is not acceptable to the customer, the customer may instead chose to have 
his/her registration fee refunded.    

The lifetime warranty applies to any disabling software problems which occur after the 90 
day period.    Any software problems reported after the 90 day period, which disables the use
of any software function, will be corrected within 30 days and the customer will receive a 
new version of the software containing corrections to the problems.    



Ombudsman Statement
K. Jeff Hayes is a member of the Association of Shareware Professionals (ASP). ASP wants to 
make sure that the shareware principle works for you. If you are unable to resolve a 
shareware-related problem with an ASP member by contacting the member directly, ASP 
may be able to help. The ASP Ombudsman can help you resolve a dispute or problem with 
an ASP member, but does not provide technical support for members' products. Please write
to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-9427 USA, FAX 616-788-
2765 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536."




